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Introduction
Thank you for purchasing FastCalXP. FastCalXP is the cornerstone of a specially designed and easy to use pressure calibration system that helps you 

calibrate pressure gauges and transmitters (collectively referred to as gauges in this manual) faster than you ever imagined. Whether you calibrate pressure 

gauges every day or only once in a while, FastCalXP saves you time, while helping you automate record keeping and reduce data entry errors.

Instead of using deadweight testers, FastCalXP was specifically designed to be used with Crystal Engineering products—pressure gauges and calibrators as 

the reference pressure standards (currently nVision, XP2i (XP2), and 30 Series calibrators) and the GaugeCalHP pressure comparator for pressure generation 

and precise pressure control. 

FastCalXP was designed to run on a modern Windows® operating system. Calibration and instrument data are stored in a Microsoft Access® compatible 

database, but reports are created in the familiar Microsoft Excel® (*.xls or .xlsx) file format. If you know how to use Excel, you can have FastCalXP produce 

calibration certificates that look exactly like the format your company uses now, including logos and any other company-specific information. Just modify the 

included Excel template spreadsheet or create your own template files. You don’t need to know anything about Access. 

Often, installing, configuring and managing other calibration software and databases is very difficult and can take a very long time. FastCalXP software is not 

only easy to use, it’s also very easy to set up—you can start to use it right away!

Read the following Installation and Quick Start sections for an overview of how FastCalXP works and for additional time saving tips and techniques to better 

use the software.

�   � WHAT FASTCALXP CAN DO FOR YOU

XX FastCalXP provides 

•	 Convenient storage of all pressure calibration related data in a single database.

•	 Automatic detection of Crystal Engineering digital reference gauges and automatic reading and storage of pressure data.

•	 Easy generation and storage of pressure test profiles.

•	 Flexible templates for certificate generation.

•	 Intuitive user interface for all calibration operations and data management.

Although deadweight testers can be accu-

rate if used properly (and it’s easy to make 

mistakes), each measurement can take a 

minute or more – so a 10 point calibration 

(10 points up and down) takes at least 20 

minutes. With FastCalXP calibration system, 

you can do it in 2 minutes!

To easily generate and set pressure pre-

cisely, use GaugeCalHP, a high pressure 

(up to 15 000 PSI or 1000 bar) hydraulic 

comparator. GaugelCalHP is not limited 

to the use of oil as the hydraulic fluid 

(many deadweight testers require oil only). 

GaugelCalHP can also use distilled water. 

We also recommend the Crystal Pressure 

Fittings system, our range of safe, quick 

connecting, and leak free fittings. They 

enable you to connect gauges without the 

need for thread sealing tape, seals, or tools.
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�   � HOW IT WORKS

A typical installation of FastCalXP includes a personal computer running Microsoft® Windows®1, a GaugeCalHP comparator and an nVision Reference Recorder, 

XP2i digital pressure gauge or 30 Series calibrator, used as the reference. The device under test, or gauge, is mounted on the comparator along with the refer-

ence and the reference is connected to the computer’s serial or USB port. 

FastCalXP stores detailed information about all tested or otherwise entered gauges, references and users as well as all acquired calibration details for each 

gauge. The flow of the program proceeds in four steps:

1	 Select Gauge Step–

2	 As Received Step

3	 As Left Step

4	 Certificate Step

FastCalXP automatically detects a Crystal digital reference connected to the computer’s serial or USB port. The software also automatically reads and records 

pressure measurements from the reference.

All of the information entered into or acquired by FastCalXP is stored in a single relational database using Microsoft Access components already on your com-

puter. Using the database, FastCalXP generates Microsoft Excel-compatible calibration certificates.

1 For the list of supported Windows operation systems, visit our website here: https://www.ametekcalibration.com/products/software/calibration-software/fastcalxp-calibration-software.

�   � USING THIS MANUAL

To quickly get started with your FastCalXP software, read the Installation and Setup section, followed by the Quick Start on page 5 section. 

More detailed sections on Calibrating Gauges, Actual Mode Calibration, and fine tuning Settings and Options follow the Quick Start section. 

Also included in this manual are reference sections for Menus and Windows, Frequently Asked Questions and Pressure Calibration Terms. Appendices 

include Appendix A: FastCalXP Pressure Units and Appendix B: Excel Template Tags.

Additional sources of information include the GaugeCalHP Operation Manual, the nVision Reference Recorder Operation Manual, the XP2i Digital Test 
Gauge Operation Manual, and the 30 Series Operation Manual.

https://www.ametekcalibration.com/products/software/calibration-software/fastcalxp-calibration-software
https://www.ametekcalibration.com/products/pump-systems/pressure-comparators/gaugecalhp-hydraulic-pressure-comparator
https://www.ametekcalibration.com/products/pressure/pressure-recorders/nvision-reference-recorder
https://www.ametekcalibration.com/products/pressure/digital-pressure-gauges/xp2i-digital-pressure-gauge
https://www.ametekcalibration.com/products/pressure/digital-pressure-gauges/xp2i-digital-pressure-gauge
https://www.ametekcalibration.com/products/pressure/pressure-calibrators/30-series-pressure-calibrator
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Installation and Setup
Included in your FastCalXP box is an installer CD, a USB authorization key, an operation manual as well as various cables and/or adapters. An optional USB foot 

switch is available.

�   � SYSTEM REQUIREMENTS

FastCalXP is a Windows application. The USB authorization key is the only additional hardware required to run the software and manage the FastCalXP data-

base. However, a typical installation includes a pressure comparator and a digital pressure gauge, or reference, along with the computer on which FastCalXP 

will be installed.

XX Computer
FastCalXP requires a personal computer with a USB port for the authorization key and a serial port, or an additional USB port if using the nVision or XP2i’s 

RS232 to USB adapter. In order to use FastCalXP, the USB authorization key must be plugged into the computer while FastCalXP is running. An additional USB 

port will be required if using the optional foot switch. For the list of supported Windows operation systems, visit our website here: https://www.ametekcali-
bration.com/products/software/calibration-software/fastcalxp-calibration-software. In order to modify certificate templates or view certificates using 

FastCalXP, Microsoft Excel (or Office) 2003 or later is recommended.

XX Comparator
FastCalXP was designed to operate with a Crystal Engineering GaugeCalHP pressure comparator.

XX Reference
For automatic reference detection and data acquisition, FastCalXP requires a Crystal nVision Reference Recorder, XP2i (XP2) digital pressure gauge or 30 Series 

calibrator connected via a serial or USB cable to the computer. 

Ideally, the calibration station will include a range of references that will provide optimal accuracy over the pressure range of each of the models normally 

tested at the station. Refer to the discussion of Reference Selection on page 14.

https://www.ametekcalibration.com/products/software/calibration-software/fastcalxp-calibration-software
https://www.ametekcalibration.com/products/software/calibration-software/fastcalxp-calibration-software
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�   � HARDWARE SETUP AND CONNECTIONS

To set up your work station, position the GaugeCalHP next to the computer monitor and keyboard. Be sure that your serial or USB cable will reach from the 

reference mounted on the rear comparator position to the serial or USB port of the computer. Also, in some modes of operation, you may need to have one 

hand on the handle of the comparator and one hand on your computer keyboard or mouse. 

If you have purchased the optional foot switch (Part no. 3327), plug the switch in to a USB port on your computer. Refer to the With the Foot Switch 
on page 21.

Refer to the GaugeCalHP Operation Manual for help with setting up the comparator.

To use FastCalXP for calibration of pressure transmitters, the following diagrams illustrate the recommended connections for measuring current output and 

digital HART signals. It is important to connect to the working terminals on the pressure transmitter to obtain accurate milliamp readings. Do not use the TEST 

terminals provided on some transmitters. These terminals may give incorrect current readings and should not be used for calibration. The polarity of the HART 

modem is not important.

Intrinsically Safe

30 Series Pressure Calibrator

Transmitter RL ≥ 250 Ω

HART
Modem

30 Series

Power Supply

Transmitter

HART
Modem

Power Supply

MA20

mA

HART

V

CRYSTAL

nVision

Intrinsically Safe

nVision  Reference Recorder

Computer Computer

30 Series Calibrator connections	 nVision Reference Recorder connections

�   � SOFTWARE INSTALLATION

If you have downloaded the software from the Internet, simply run the downloaded executable and follow the instructions to complete the installation. 

If you have an installation CD, insert the CD into the drive on your computer and setup will run automatically. If setup fails to start, run the FastCalXP2.1Setup.
exe from the CD. Follow the instructions in setup to complete the installation. 

https://www.ametekcalibration.com/products/pump-systems/pressure-comparators/gaugecalhp-hydraulic-pressure-comparator
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Quick Start
This section provides a summary of the four basic steps needed to complete a calibration using FastCalXP. It is intended to get you quickly up and running 

upon installation and to provide a guide for the new user of an existing installation.

The four basic FastCalXP steps are displayed in the center of the main window and following the steps from left to right will get you through a calibration ses-

sion. At the completion of any step it is possible to return to any previous step using the back arrows.

Before attempting calibrations, verify that your work station is set up as described above.

�   � SET UP THE CALIBRATION

1	 Run FastCalXP. After the initial installation, FastCalXP does not require a username or password. However, if the Login option has been engaged, FastCalXP 

will prompt you for your username and password.
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The first time you run FastCalXP after installation, the software will prompt you to locate the database or specify the name and location of a new database.

 You will also be prompted to select a location for the storage of certificates.

2	 Load the Gauge. Lookup existing gauge or create a new gauge using the New Gauge Wizard. The New Gauge Wizard will take you through the addition of a 

new gauge in the steps listed below. Refer to the discussion of the New Gauge Wizard on page 9 for more detailed information about adding a gauge.

(a)	 Select or add a manufacturer.

(b)	 Select or add a model. The New Model Wizard will take you through the process of adding a new model in two steps:

Enter model information.

Select or build a test profile. Refer to the discussion of Test Profiles on page 39.

(c)	 Select or add a location. A location is not required. However, it is commonly used to specify the operating location of the gauge within the user’s facility 
or, by a calibration laboratory, for customer information.

(d)	 Enter information about the gauge.

(e)	 If the model selected is a smart transmitter measuring HART you will need to enter the HART ID details of the transmitter or click on the 
Discover… button to automatically populate the information.

Refer to the detailed discussion of the New Gauge Wizard on page 9 

3	 Connect the gauge as described in the discussion of Hardware Setup and Connections on page 4 and in the GaugeCalHP Operation Manual. 

4	 Choose a reference with appropriate accuracy. For example, metrology guidelines suggest a four-to-one accuracy ratio of the reference to the gauge. Refer 

to the discussion of Reference Selection on page 14 for more detail.

5	 Connect the reference as described in the GaugeCalHP manual. Connect the serial cable to the reference and to the computer’s serial port. By default, 

FastCalXP will look for the reference on the first serial port. Refer to Settings and Options on page 26 for help with changing the serial port.

https://www.ametekcalibration.com/products/pump-systems/pressure-comparators/gaugecalhp-hydraulic-pressure-comparator
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�   � TAKE THE AS RECEIVED DATA

XX Perform a New Calibration.

1	 Click the Perform As Received Cal button. 

2	 The Calibration Wizard will auto-detect the reference as described in the discussion of References. 

If a new reference is detected, the Calibration Wizard will prompt you to enter the current certificate information for the reference. If using an nVision with 

two modules you will be prompted to select one of the modules to use for the calibration.

3	 If the profile requires it, exercise the gauges by increasing and decreasing the pressure over the full range of the gauge one or more times. Refer to the 

GaugeCalHP Operation Manual or the discussion of Exercising on page 17 for more information.

The Calibration Window will then open. Refer to description of the Calibration Window in the Menus and Windows section. 

4	 Select Actual or Peak mode and step through the calibration. Refer to the discussions of Calibration Strategies, Actual Mode Calibration, and Peak Mode 
Calibration later in the manual.

XX Load Existing As Received Data.

�� If the As Received calibration has been completed in a previous session, complete the As Received Step by clicking the Load Previous Data button.

�   � TAKE THE AS LEFT DATA

If the gauge failed the As Received calibration and adjustments have been made to the gauge, click on the Perform As Left Cal button. Follow steps 2 through 

4 in the Perform a New Calibration instructions above.

Alternatively, if the gauge passed the As Received calibration and no adjustments have been made to the gauge, FastCalXP can use the As Received calibra-

tion for the As Left calibration. Click on the Use As Received for As Left button.

�   � GENERATE AND PRINT THE CERTIFICATE

1	 Enter any notes regarding the calibration or modifications made to the gauge in the Calibration Notes/Modifications box and click on the Save Data button 

in the Calibration Status box. Notes cannot be added after the certificate has been generated.

2	 Create the calibration certificate by clicking on the Generate Certificate button. FastCalXP will create the certificate and open the certificate by running 

Excel. Go to the Excel window with the current certificate and print the certificate. 

Refer to the Creating Certificates section for more information on working with certificates.

https://www.ametekcalibration.com/products/pump-systems/pressure-comparators/gaugecalhp-hydraulic-pressure-comparator


Calibrating Gauges   8

FastCalXP Operation Manual

Calibrating Gauges
This section describes, in detail, many of the concepts referred to in the Quick Start section above.

�   � GAUGES

FastCalXP refers to the device under test (DUT) as the gauge. Gauges are the heart of the FastCalXP database. 

Before beginning a calibration, FastCalXP must load the gauge. Load an existing gauge or use the New Gauge Wizard to create a new gauge. 

Refer to the Managing the Database on page 33 for detailed information about managing gauges with the database manager.

XX Loading a Gauge

1	 To load an existing gauge, click on the Lookup Existing Gauge button from the Select Gauge Step column, choose Lookup Existing Gauge from the File 

menu (Ctrl+O) or use the Lookup Gauge button on the toolbar. 
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2	 Select a gauge from the list or search for a gauge.

If searching for a gauge, select a search type from the dropdown and enter the search criteria.

3	 Click OK to load the gauge then connect the gauge as described in the GaugeCalHP manual.

XX New Gauge Wizard
To create a new gauge, click on Create New Gauge button from the Select Gauge Step column, choose Create New Gauge from the File menu (Ctrl+N) or use 

the New Gauge button on the toolbar. This will open a wizard which will take you through the steps for adding a new gauge to the database:

1	 Select a manufacturer from the pull-down list. If the manufacturer of the gauge you are creating has not been previously entered into the database, click on 

the Add New Manufacturer button. 

2	 Enter manufacturer information in the Name, Address, Phone, FAX and Web address text boxes. In addition there is space to enter notes. Only the Name 

field is required.
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3	 Select a model from the pull-down list. If the model of the gauge you are creating has not been previously entered into the database, click on the Add New 
Model button. The Add New Model Wizard will step you through the creation of a new model in two steps.

The initial dialog box allows you to enter the model information.

4	 Enter the Model number or name and select the Units of measure from the pull-down list.

5	 Enter the Pressure range measured by the model.

6	 Specify the increment represented by the Resolution of the gauge or transmitter.

When Use custom certificate template is checked, you can override the default Excel template defined in the FastCalXP Options dialog. This allows this 

model to have a unique certificate format.

7	 Enter the Cal Interval, in days, which will be used for calibration scheduling.

If you will be calibrating a transmitter, check the Transmitter box and select the parameters that you wish to measure. If you wish to Measure mA, check 

the box, enter the Low and High PSI represented by the range of mA readings for the transmitter. In addition, it is possible to Measure local display or 

Measure HART signals through a connected HART modem.

Note: The default certificate template will change depending on the chosen transmitter configuration. Also, if Measure HART is selected, the Resolution will 

automatically be adjusted to the resolution of the connected pressure standard.



Calibrating Gauges   11

FastCalXP Operation Manual

8	 Select the Accuracy of the gauge from the pull-down list or specify a % of span or Custom accuracy.

Refer to the discussion of Models on page 36 in the Managing the Database section.

9	  Click Next to select the As Received and As Left calibration Profiles.

If the desired profiles are not listed, click on the Create New Profile button to open the Profiles editor. Refer to the discussion of Test Profiles on page 39.

10	 Select a location from the pull-down list or click on the Add New Location button.

A location is not required. However, it is commonly used to specify the operating location of the gauge within the user’s facility or, by a calibration labora-

tory, for customer information. Use the boxes provided to enter specific location information and notes
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11	 Enter gauge information.

The Gauge number is your number for this particular gauge – its identifier. This number is required and it must be unique among all gauges stored in the 

database. Choose the gauge number carefully since the number will be used in the future to identify this specific gauge from, potentially, a large number of 

gauges stored in the database. 

The Serial number is that which is provided by the manufacturer. The serial number, along with model and manufacturer is a second method of uniquely 

describing the gauge.

The Nickname is not required but may provide another useful description for the gauge.

Calibration due is the date this gauge is next scheduled for calibration. When a calibration has been completed and a certificate created, this date is up-

dated automatically using the calibration interval specified for the model.
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If the new gauge is a transmitter and Measure HART was selected, the New Gauge Wizard will display a HART Information dialog box.

The Manufacturer ID, the Device type ID and the Device ID combined together form the unique ID, defined by the manufacturer, that is used to communi-

cate with a smart transmitter during the calibration session. This ID can be entered manually by consulting the transmitter documentation or determined 

automatically by FastCalXP.

12	 If the smart transmitter is powered on and connected to a HART modem which is connected to one of the computer’s serial ports, click on the Discover… 
button to automatically poll the default com port for HART information.

13	 If the HART modem is not connected to the default COM port, click Stop. Select the correct COM port from the pull-down list and press the Start button. 

The HART Modem will poll the network for any devices connected and display the results. Select the desired HART device from the list and press the 

OK button to enter the ID of the desired transmitter.

14	 Click the Finish button to store the new gauge and close the New Gauge Wizard.

When the New Gauge Wizard has been completed FastCalXP will automatically load the new gauge.
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XX Calibration Schedule
FastCalXP keeps track of the calibration schedule for all gauges and references in the database.

1	 To view a list of upcoming calibrations, choose Upcoming Calibrations Report from the View menu.

2	 Use the radio buttons to view a list of Gauges or a list of References.

The time span over which FastCalXP looks for upcoming calibrations is specified under the Config Settings tab of the FastCalXP Options. Refer to the discus-

sion of Settings and Options on page 26.

�   � REFERENCES

A reference is the digital pressure gauge to which the gauge under test is compared during a calibration. FastCalXP is designed to work with Crystal Engineer-

ing’s nVision Reference Recorder, XP2i (XP2) digital pressure gauges, and 30 Series calibrators connected to the computers serial or USB port.

In addition to pressure references, the FastCalXP database can store references used to verify ambient conditions at the calibration work station such as ambi-

ent air pressure, temperature and humidity. These references can be automatically listed on all certificates. Refer to the discussion of Managing References in 
the in the FastCalXP database in Managing the Database on page 33.

Reference Selection

Reference selection is perhaps the most important factor in ensuring the most accurate calibration possible. Many metrology and/or quality systems require 

that the uncertainty of the reference be at least 4 times better than the device being tested, but your metrology requirements may be different. 

Crystal XP2i Digital Test Gauges have an accuracy of ±(0.02% of full scale) in the lower 20% of their ranges and an accuracy of ±(0.1% of reading) in the remain-

der of the range. 30 Series calibrators have an accuracy of ± (0.05% of reading plus 0.005% of full scale). nVision Reference Recorders have various accuracy 

statements from range to range. Some ranges have 0.025% of reading accuracy from 30% to 100% of full scale. All Crystal products are available with a variety 

of pressure ranges to suit a wide range of needs.
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Autodetection

FastCalXP automatically detects Crystal Engineering’s nVision Reference Recorders, XP2i (XP2) digital pressure gauges and 30 Series calibrators. Once the 

gauge and the reference have been mounted on the GaugeCalHP and the serial or USB cable has been connected to the reference and the computer’s ap-

propriate port, the autodetection and calibration can proceed. Calibration of a smart transmitter with a HART modem requires that the HART modem be 

connected to the computer and the HART modem leads be connected to the power leads of the transmitter. Refer to the Hardware Setup and Connections 
section and to the GaugeCalHP Operation Manual for help with configuring your calibration work station. 

XX To Automatically Detect a New or Previously Used Reference

1	 Turn the reference on and click the Perform New As Received Cal button or the Perform As Left Cal button.

FastCalXP will take a few seconds to detect the reference. When a new reference has been detected it can be added to the database and the current calibra-

tion certificate information must be entered by the operator.

2	 Enter the Latest calibration certificate number and the date on which that Certificate expires.

If the auto-detected reference exists in the database, FastCalXP will proceed to the Exercise Window or to the Calibration Window. 

If the reference is not automatically detected refer to the Frequently Asked Questions. 

XX Adding References Manually

�� References can be added manually using the Database Manager. Refer to the Managing References on page 42.

https://www.ametekcalibration.com/products/pump-systems/pressure-comparators/gaugecalhp-hydraulic-pressure-comparator
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�   � TEST PROFILES

Test profiles are the standardized series of pressure levels used for the calibration of each model. Thus, there is a profile for As Received calibrations and a 

profile for As Left calibrations associated with each model in the database. 

XX To Select a Test Profile

Test profiles can be specified within the New Model Wizard (accessed via the New Gauge Wizard).

1	 Use the AR test profile and AL test profile pull-down lists to select a test profile for the As Received calibration and a test profile for the As Left calibration.

2	 If the desired profile is not listed, click the Create New Profile button to open the Profiles editor.

Refer to the discussion of Test Profiles in the Managing the Database section for help with the Profiles editor.

XX To Edit a Profile or Add a New Profile Outside of the New Model Wizard

�� Choose Manage Database from the Tools menu and click on the Profiles button to open the Profiles editor. 

To change the profiles that are associated with a model

1	 Choose Manage Database from the Tools menu and click on the Models button to open the Models editor. 

2	 Select the desired model and choose the desired profiles from the pull-down lists for AR test profile and AL test profile.

3	 If a desired profile is not listed, click the Create New Profile button to open the Profiles editor.

When the profile has been created, return to the Models editor and select the profile from the pull-down list.
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XX Associate More Than One Set of Profiles to a Specific Model
Imagine, for example, you have a number of Nuova Fima EN837-1 40 Bar gauges and some require a standard nine-point calibration but others, because 

of the task that they perform, require a finer 17-point calibration. In this case you would create two models, identical except that they would have different 

names, such as EN837-1 Coarse and EN837-1 Fine, and different calibration profiles associated with them.

�   � CALIBRATION STRATEGIES

The following discussions provide detailed instructions for getting through a calibration using the various modes and approaches available with FastCalXP. 

These discussions also provide information which should help you to establish your own protocol for pressure gauge calibration.

Regardless of the protocol that you settle on, practice will improve your speed and accuracy. Take your time and do not hesitate to retrace your steps. A cali-

bration is only finalized when it is saved following completion of the profile.

Exercising

Exercising the gauges prior to completing a calibration may improve the accuracy of the calibration. Exercise the gauges by applying the full scale pressure of 

the gauge one or more times. Refer to the GaugeCalHP Operation Manual for a more detailed discussion of exercising the gauges. 

FastCalXP provides an Exercise Window to encourage completion of exercise cycles prior to a calibration. The number of exercise cycles is associated with the 

profile and specified in the Profiles editor.

https://www.ametekcalibration.com/products/pump-systems/pressure-comparators/gaugecalhp-hydraulic-pressure-comparator
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XX To Change the Number of Exercise Cycles Associated with a Profile

1	 choose Manage Database from the Tools menu and click on the Profiles button.

2	 Select the profile of interest and click on the Edit button.

3	 Enter the desired number of exercise cycles in the Number of exercise cycles text box. 

Matching the Target

Two different approaches can be taken while stepping through a calibration profile: matching the gauge to the Target Pressure or matching the reference to 

the Target Pressure. 

During a calibration, the Target Pressure is the next profile value and the Reference and Gauge pressures are indicated below. The Gauge value is, by default, the 

same value as the Target Pressure. However, the value can be changed by the user to match what is read from the gauge.

XX To Match the Gauge to the Target Pressure

1	 Read the gauge while turning the handle of the GaugeCalHP.

2	 Stop when the gauge reaches the Target Pressure value.

Matching the gauge allows for much faster calibration since interpolation is not required to read the gauge and the Gauge value does not have to be 

entered.
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XX To Match the Reference to the Target Pressure

1	 Turn the handle of the GaugeCalHP until the Reference matches the Target Pressure.

2	 Read the gauge and enter that value in the Gauge box.

The number you enter may be modified based on the minor graduation or resolution of the gauge as it is specified.

Transmitter Calibration

When performing transmitter calibration an nVision (with an MA20 module and a Pressure module installed) and/or HART modem is required, depending on 

what type data needs to be collected. A 30 Series pressure calibrator may also be used in place of the nVision. The model definition for the gauge will define 

the requirements for the transmitter. 

If the transmitter model includes milliamp output, then the reference must be an nVision or 30 Series pressure calibrator. If you are calibrating a smart trans-

mitter, a HART modem must be connected to the computer and the leads must be connected to the power leads of the smart transmitter. See Hardware 
Setup and Connections for a diagram of the correct electrical connections.

Note that while a HART modem is necessary to read the HART digital pressure signal from a smart transmitter, it is not required to calibrate this type of trans-

mitter if an nVision or 30 Series pressure calibrator is used as the reference. Also, it is not possible to change the digital signal without using a HART communi-

cator. The use of a HART communicator is not discussed in this manual.

The HART indicated pressure is acquired using the connected HART modem by querying the transmitter using the HART address information entered when 

creating the gauge. FastCalXP also uses the mA low range value and mA high range value from the model information to compute the pressure from the 

measured milliamps. Note that the milliamp pressure reading is computed from the measured milliamps and will most likely will not be the same value as the 

HART pressure reading.
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The Adiabatic Effect

Regardless of what fluid is used in the comparator there will always be a small amount of air remaining between the fluid and the gauge sensor. When pres-

sure is increased in the comparator the air is pressurized and this pressurized gas heats up. When the pressure stops increasing, the gas cools and the pressure 

in the comparator decreases slightly. The reverse is true when the pressure is reduced in the comparator. This is called the adiabatic effect. 

The result of the effect for FastCalXP is that the pressure is not immediately stable when a new target pressure is reached. At high pressures, the adiabatic ef-

fect can be large. For example, at 10 000 PSI the pressure can change by 100 PSI or more as the gas stabilizes thermally.

With FastCalXP, there are two approaches to working with the adiabatic effect. One approach is to adjust the comparator and wait for the pressure to stabilize. 

This approach is used in the Actual data acquisition mode. The other approach is to take advantage of the adiabatic effect with the Peak data acquisition mode.

Actual or Peak Mode calibration can be selected in the Calibration Window. Refer to the discussions of the techniques used in Actual Mode Calibration on 
page 21 and Peak Mode Calibration on page 22.

XX To change the default Data Acquisition Mode

�� Choose Options from the Tools menu and click on the Calibration Settings tab. 

Completing a Calibration

When the exercising is complete and the data acquisition mode has been selected, the calibration process can begin.

1	 Even in auto peak mode, the first zero-level measurement must be made manually by pressing Enter, clicking on the Next Point button, or pressing the foot switch.

Refer to the discussions of Actual Mode Calibration on page 21 and Peak Mode Calibration on page 22 for guidance with making measurements.

As the calibration progresses, the gauge will pass or fail at each profile point, or Target Pressure. To pass, the Gauge must be equivalent to the Reference 

within the tolerance range. The tolerance is defined as the accuracy of the gauge at the measured pressure. The data is displayed in a box at the right of the 

calibration window.

Failed profile points are shaded red. The gauge must pass at every profile point to pass the calibration.

2	 Use the Back buttons
  

to return to a previous step or to start over.
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�   � ACTUAL MODE CALIBRATION

When FastCalXP is operating in Actual Mode, the Reference value that is taken for any point is the pressure reading from the reference at the moment that 

the keyboard Enter key is pressed, the Next Point button is clicked, or the foot switch is pressed. Actual Mode is the easiest mode of operation for the novice 

operator. Typically, this is the mode that will be used for calibration of digital gauges and transmitters.

With the Foot Switch

The optional foot switch will significantly increase operation speed in Actual Mode since it enables hands-free storage of a measurement. Without the need 

to use your hands to store a measurement manually, one hand can operate the comparator while the other taps the gauge. In all calibration modes, the foot 

switch operates as the Next Point button.

XX To Make an Actual Mode Measurement

1	 Turn the handle of the comparator until the gauge reaches the Target Pressure.

2	 Press the Foot Switch when the gauge needle points to the target pressure.

If you are matching the Target Pressure to the reference, you will have to enter the reading from the gauge in the Gauge box before you press Enter.

XX To Re-measure a Profile Step

�� Click on the Previous Point button and adjust the comparator to reach the target again.

Without the Foot Switch

Without the foot switch, you will need to work with one hand on the comparator and one hand on the keyboard or mouse. 

XX To Make an Actual Mode Measurement

1	 Turn the handle of the comparator until the gauge reaches the Target Pressure.

2	 Press the Enter button or click on the Next Point button. 

If you are matching the Target Pressure to the reference, you will have to enter the reading from the gauge in the Gauge box before you press the Enter 
button.

XX To Re-measure a Profile Step

�� Click on the Previous Point button and adjust the comparator to reach the target again.
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�   � PEAK MODE CALIBRATION

Peak Mode calibration uses FastCalXP’s peak detection capability to take advantage of adiabatic pressure changes. In Peak Mode, the Reference reading is the 

largest (or smallest when descending) value recorded by the reference since the peaks were last cleared. FastCalXP will determine automatically whether you 

are ascending or descending in order to correctly pick a maximum or minimum for the “Peak.”

Peak Mode will typically be used to calibrate analog gauges since it is possible to visually align the needle at the next point. Peak Mode is not recommended 

for digital devices.

Peak Mode with Auto Peak Detection

Auto Peak Detection mode provides the fastest way of performing a calibration for the experienced operator. With Auto Peak turned on, FastCalXP will auto-

matically detect a peak in the ascending portion, or valley in the descending portion of the profile, record the value reached at the peak or valley and advance 

to the next profile point. 

Auto Peak mode is set up specifically for calibrations where the gauge is being matched to the Target Pressure value. 

XX To change the default to Peak Mode with auto detection

1	 Choose Options from the Tools menu and click on the Calibration Settings tab.

2	 Select the Peak calibration method.

You will also have the option of specifying the number of readings to look at in determining if a peak has been reached. The default is five but the optimal 

number will depend on the individual operator’s speed and will likely be determined experimentally. A number that is too high will cause a delay in the 

detection of the peak and a number that is too low will cause FastCalXP to detect undesired peaks. 

XX To Make a Measurement in Peak Mode with Auto Detection

1	 Turn the handle of the comparator smoothly and steadily until the gauge reads the Target Pressure value.

2	 Stop, wait for the program to beep and record the data point. 

3	 Turn the handle again for the next profile step.

XX To Clear the Last Profile Step in Peak Mode with Auto Detection

1	 Turn the handle of the comparator to back off from the last pressure step.

2	 Click the Previous Point button and approach the target again. 



Creating Certificates   23

FastCalXP Operation Manual

Creating Certificates

�   � CERTIFICATE BASICS

Certificates are meant to be enduring documents that record the calibration of gauges. They are Excel .xls or .xlsx format documents with one or more work-

sheets each. For the most part, certificate data cannot be edited in the database once the certificate has been created, although the Excel worksheets can be 

password protected to enhance the security of the data.

When As Received and As Left calibrations have been completed the certificate can be created, viewed and printed. Since all of the data for the certificate is 

retained in the database, the certificate can be recreated at any time.

XX To add notes to a calibration

1	 Type the notes into the Calibration Notes / Modifications box in the lower right of the main window.

2	 Click on the Save Data button in the Calibration Status box.

Notes cannot be added after the certificate has been generated.

XX To create a certificate from loaded data

�� Click the Generate Certificate button. 

FastCalXP will create the certificate and open it in Excel. The certificate can then be viewed and printed.
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�   � EXCEL TEMPLATES

One of FastCalXP’s greatest strengths is the ability to create custom certificates using an Excel template. This allows the certificate to be fully customized, in-

cluding the use of graphics and foreign languages. Each model in the database can have a different template, allowing for the greatest flexibility in generating 

certificates.

FastCalXP creates certificates by filling an Excel template with the appropriate stored data, replacing tags that identify the fields that are to be filled. Fast-

CalXP does search-and-replace operations in each worksheet in the template that includes a certificate number tag. Refer to Appendix B: Excel Template 
Tags for a list of tags that can be included in the certificate templates. 

Tags are organized in a hierarchy so that the software will not search for tags that are lower in the hierarchy unless it has already found associated upper level 

tags. For example, reference fields will not be filled unless there is a reference number tag associated with those fields. Bold tags listed in Appendix B: Excel 
Template Tags are necessary tags in the tag group with which they are associated. 

The number sign that is included in some of the tags is a placeholder indicating that numbering is required. FastCalXP will not add fields to a template when it is 

creating a certificate but it will empty all unused fields. For example, if the template only contains tags for 5 data points, but the profile contains 10 data points, 

only the first 5 data points will be placed in the certificate.

Worksheets within the template can be password protected if the Excel password is set in the Options dialog (see Settings and Options on page 26). Every 

sheet in the workbook will be password protected, even if no tags exist on a sheet. 

Templates are associated with models. A standard template is provided with the FastCalXP software. This template can be copied and edited to create any 

number of different templates. Refer to Excel documentation for help with creating Excel templates. 

XX To Create a New Template

1	 Copy the provided template

2	 Rename the copy and edit the new template in Excel.

Make sure there are enough fields and tags for the number of data points to be collected. 

XX To Specify the Default Template

1	 Choose Options from the Tools menu and click on the Certificate Settings tab.

2	 Browse to find the desired template.

Take care in making this change, as this will affect all models that do not have the checkbox Use custom certificate template checked. 

XX To Change the Template That is Associated with a Model for Models That Have a Custom Template Selected

1	 Choose Manage Database from the Tools menu and click on Models.

2	 Select the desired model, click Edit and use the Browse button to find the desired template. 
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�   � VIEWING CERTIFICATE DATA

Before creating a certificate, you may wish to look at the data from the current calibrations or from an older certificate.

XX To View Data from a Current or Previous Certificate

1	 Open the Excel certificate or load the data into FastCalXP. 

2	 Load the data for a specific certificate one of two ways.

(a)	 Choose Load Certificate Data from the File menu to select certificate data for the gauge that is currently loaded.

(b)	 If you know the certificate number or gauge number that you are looking for, choose Lookup Certificate from the Tools menu and enter the number.

3	 Once the data is loaded, click the View Detailed Data button located next to the summary at the bottom of the main window. 

You may need to use the scroll bars to view the entire dataset.
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Settings and Options

�   � OPTIONS

FastCalXP settings can be modified by choosing Options from the Tools menu. By default, this menu item not available when a technician is logged on. Log on 

as an administrative operator to access Options. 

The FastCalXP Options dialog box allows configuration in four areas available via four tabs.

Config Settings

The Config Settings tab provides access to system defaults. 

XX Default Calibration Interval
Specify a Calibration interval that will be used as a default for all newly created models.

XX Default Pressure Unit
Specify a Pressure unit that will be used as a default for all newly created models.

XX Multiple Database Support
The Multiple database support checkbox enables the management of multiple databases. For help with multiple databases, refer to Multiple Database Sup-
port in the Managing the Database on page 33.

XX Cal Due Report Window
Specify how far in advance you wish to be warned of upcoming calibrations in the Upcoming Calibrations Report by adjusting the number of days in the Cal 
due report window.
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XX XP2/Model 30 Serial Port
The XP2/Model 30 serial port specifies which port FastCalXP will look at to find the Crystal reference.  Typically, this is set to ‘Auto’, and FastCalXP will automati-

cally detect the serial port to which the gauge is connected. Change to the specific serial port if your configuration requires it.

XX HART Modem Serial Port
The HART modem serial port specifies which port FastCalXP uses to connect to the HART Modem while calibrating transmitters. Choose the serial port to which 

your HART Modem is connected.

XX Language
The Language selection will list all available languages for FastCalXP that have been installed. Language packs are available through your local distributor as 

well as online at http://www.crystalengineering.net. After changing the language, you will need to restart FastCalXP before the change will take affect.

XX Use Custom Audio Alert
The Use custom audio alert checkbox allows you to change the sound that is played when FastCalXP automatically advances to the next pressure point during 

calibration.

Certificate Settings

Certificate Settings define the ways certificates are generated and saved. 

XX Default Certificate Template
The Default certificate template is the calibration certificate template that will be used, by default, for creating certificates. This can be overridden by check-

ing Use custom certificate template in the model configuration. Refer to the Creating Certificates section for a discussion on creating and editing certificate 

templates. Refer to Models in the Managing the Database section for information on selecting alternate templates.

XX Default Excel Version
Specify an Excel Version that will be used as a default for all newly created certificates. The default setting is .xls files in Excel 97-2003 format.
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XX Save Certificates To
The calibration certificates created by FastCalXP will be saved in the directory specified in Save certificates to.  This directory is set the first time the software is 

run after installation or when a new database is created and can be changed here using the Browse button.

XX Certificate Naming Template
The Certificate naming template is used by FastCalXP to name the calibration certificates. In general, certificates are numbered with the Next certificate 
number incrementing automatically each time a certificate is created. Use number signs (#’s) in the Certificate naming template to define the number of digits 

to be used.

XX Calibration Representative and Quality Representative
The Calibration representative and the Quality representative must be listed users and can be selected using the pull-down lists.  In the certificate template 

provided with the software these names will be listed, with signature lines, on the first page of each certificate. 

Calibration Settings

The Calibration Settings define the default Calibration Method. 

XX Actual
Uses the pressure reading from the reference at the moment the Next Point button is clicked.

XX Peak 
Automatically advances to the Next Point when a peak is detected.

XX Head Correction 
If the gauge and the reference do not sit at the same height, a Head correction can be applied. Enter a correction to be added to the reference pressure, or use 

the Correction calculator to calculate a correction given the specific conditions of the calibration. Refer to the discussion of the Head Correction Calculator 
on page 32.
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Login Options

The Login Options allow the administrator to enable the login feature of FastCalXP. The login feature allows control over who uses the software. In addition, 

the feature provides a record in the database of which user performed each calibration and of which user created each certificate. The Login Options tab is not 

available to technicians.

XX No Login
Disables the user login feature.

XX Automatic Login 
A specified user is automatically logged in each time the program is run.

XX Require Login
Requires any user to enter a valid user name and password. If a valid user name and password is not specified, FastCalXP will not run.

When a user is logged in, the name of the user is displayed in the Status Bar at the bottom of the FastCalXP main window. The privileges of the user will be 

determined by the user type (administrator or technician) and the Security Settings as discussed below.

XX To Log In When Login is Disabled

1	 Choose Login from the File menu. The login dialog will be displayed.

2	 Enter your Username and Password.
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Security Settings

The Security Settings allow the administrator to set the privileges of technicians. The Security Settings tab is not available to technicians. 

XX Grant Technicians Access to the Options dialog
Allows technicians access to the Config Settings and Calibration Settings dialog boxes.

XX Grant Technicians Ability to Create/Edit/Delete the Following Items
When Manage Database is selected from the Tools menu, the technician will have access to the items selected in the check boxes. All other buttons will be 

grayed out. 

XX Password Protect Certificates
Enables the user to set a password to each sheet of the Excel calibration certificate to prevent modification after the certificate has been generated. All work-

sheets within the workbook will be protected with this password.
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�   � WHERE SETTINGS ARE STORED

While most settings and options are stored within the database, some settings, such as the serial port, are stored separate from the database and apply to all 

databases. If you are only working with a single database, you can ignore this section as it will have no affect on you. However, if you use multiple database 

support, it is important to understand that some settings are unique to the database you are using, while others only need to be set once for all databases. 

The following settings apply to all databases and only need to be set once: 

XX Options Dialog: Config Settings tab

•	 Multiple database support

•	 Language selection

•	 XP2/Model 30 serial port

•	 HART Modem serial port

XX Options Dialog: Calibration Settings tab

•	 Calibration method

•	 Peak detection settings

•	 Head correction

XX Options Dialog: Security Settings tab

•	 All security settings except certificate password.

XX Change Database dialog

•	 Choosing database on startup setting

All other settings are stored within the database. This means that when you change any setting not included in the list above, it affects only the current 

database. If you want to change a setting not in the list above, but have it affect all of your databases, you will need to switch to each database and make the 

change.
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�   � HEAD CORRECTION CALCULATOR

The Head Correction Calculator is accessed via a button under the Calibration Settings tab.

The calculator uses Fluid density, Gravity and Height change to calculate a correction that is added to the pressure measured by the reference. 

Four standard fluid densities, for Isopropyl Alcohol at 25°C, Pure Water at 4°C, Pure Water at 20°C and Air at 15°C and sea level, can be applied using the buttons 

in the Head Correction box.

The local gravity can be estimated using the local Latitude and the altitude above Mean sea level. Enter these values and click on the Calculate Gravity button. 

The calculated gravity will automatically be entered into the Gravity field in the Head Correction box.

When the appropriate parameters are entered, click on the Calculate Head Correction button to display the calculated Head Correction. Click OK to insert the 

correction into the head correction box in the Calibration Settings.
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Managing the Database
The FastCalXP database stores all of the information entered into or acquired by the program. The database is a Microsoft Access format database that is ac-

cessible from within FastCalXP. All user-entered data related to Gauges, Units, References and Users can be edited by an administrator. Administrator-defined 

privileges may also permit access to some portions of the database by a technician. Refer to the discussion of Security Settings on page 30 in the Settings 
and Options section.

Calibration data collected by FastCalXP cannot be edited by the user. This data can be viewed and printed in the form of certificates only.

XX To Modify or Add to the Editable Portions of the Database

�� From the Tools menu, choose Manage Database to open the Database Manager.

For management purposes, the database consists of eight tables which can be accessed via the buttons in the Database Manager. 

XX  To Change the Current Database

�� Click the Change button in the lower right corner of the Database Manager.

If Multiple Database Support has been enabled in the Options dialog, you will be taken to the Select FastCalXP Database dialog. Otherwise, use the Open 

dialog to browse your directories to find the .MDB file that you wish to load. 
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XX To add to or edit a table

�� Click on the button for that table.

Each dialog, or table editor, includes a list of items on the left, item details in the center which can be edited, and action buttons on the right. A checkbox at the 

bottom left allows you to display hidden items in the list. A checkbox at the bottom center allows you to specify whether or not the current item is hidden.

XX To add a new item

�� In the table editor, click on the New button and enter the details in the center box.

XX To edit an existing item

1	 In the table editor, select the item from the list on the left.

2	 Click the Edit button and modify the details as desired.

XX To end an editing session

�� Click on one of the action buttons on the right:

•	 Click OK to save the changes and exit the editor.

•	 Click Save to save the changes but leave the editor open.

•	 Click Cancel Edit to abandon the changes and leave the editor open.

�   � GAUGES

The Gauges editor allows access to the data associated with all gauges in the database. The Gauge Details section in the center of the editor includes seven 

fields containing identifying information about the currently selected gauge. Most of these fields are required.
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XX Gauge number
The Gauge number is your number for a particular gauge—its identifier. This number is required and it must be unique among all gauges stored in the 

database. Choose the gauge number carefully since the number will be used in the future to identify this specific gauge from, potentially, a large number of 

gauges stored in the database. 

XX Manufacturer and Model
Use the pull-down lists to select a Manufacturer and Model from those stored in the database. If the desired manufacturer and model are not listed, click on the 

Create New Model button to open the Models editor.

XX Serial number
The Serial number is that which is provided by the manufacturer. The serial number, along with model and manufacturer, is a second method of uniquely 

describing the gauge. 

XX Nickname
A Nickname is not required but may provide another useful description for the gauge.

XX Location
A Location is not required. However, it is commonly used to specify the operating location of the gauge within the user’s facility or, by a calibration laboratory, 

for customer information. If you wish to enter a location but do not see the desired location listed, click on the Create New Location button to open the Loca-

tions editor.

XX Calibration due
Calibration due is the date a gauge is next scheduled for calibration. When a calibration has been completed and a certificate created, this date is updated 

automatically using the calibration interval specified for the model.

If the model selected is a transmitter with HART communication, three numbers combined together form the unique ID used to communicate with the trans-

mitter during the calibration session. These fields will be available for editing.

XX Manufacturer ID
The Manufacturer ID is a number assigned to the manufacturer by the HART Communication Foundation. Consult the documentation for the transmitter if 

you do not know this number.

XX Device type ID
The Device type ID is that which is assigned by the manufacturer identifying a particular device model.

XX Device ID
The Device ID is that which is assigned by the manufacture that is unique within the Device type ID for this manufacturer.
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�   � MODELS

The Models editor allows access to the data associated with all models stored in the database.

 

XX Model
The Model name is normally simply the name of the model provided by the manufacturer. However, if you wish use different test profiles on different groups of 

a single manufacturer’s model, you may need to add a modifier to the model name that will help you recognize which test profiles will be used for calibration.

XX Manufacturer
Use the pull-down list to select a Manufacturer from those stored in the database.

XX Units of Measure
Use the pull-down lists to select the Units of measure.

XX Pressure Range
Specify the Pressure range and the value associated with each tic or Resolution of the gauge.

XX AR and AL Test Profiles
From the pull-down lists, select test profiles for As Received (AR) and As Left (AL) calibrations. Specify the number of runs through each profile, or Qty. If the 

desired profile is not listed, click on Create New Profile to open the Profiles editor.
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XX Use Custom Certificate Template
When Use custom certificate template is checked, you can override the default Excel template defined in the Options dialog. This allows different manufactur-

ers or models to have unique certificate formats.

XX Cal Interval
Enter the Cal interval (in days) which will be used for calibration scheduling.

XX Transmitter
 Select Transmitter when you will select which parameters of the transmitter to measure during calibration.

XX Measure mA
Select Measure mA when calibrating the analog output of the transmitter. Specify the Low/High pressure range as well as the corresponding Low/High mA 

output of the transmitter.

XX Measure HART 
If the model is a smart transmitter, select Measure HART to view digital output of the transmitter. If the transmitter has an external display check Measure 
Displayed to include the external display in the certificate. You can select either Measure Displayed or Measure HART but not both for a model.

XX Accuracy
There are three ways to define the accuracy of the model. Many gauges will have an ASME or ISO/IEC grade which can be selected from the pull-down list. If 

the accuracy is not listed, you may be able to simply enter a % of span accuracy.

Alternatively, select Custom to define a custom accuracy by specifying a series of pressure ranges and accuracies associated with those ranges. Click the Add 
button to include a range and accuracy in the specification. When the accuracy is fully specified, click OK.
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�   � MANUFACTURERS

The Manufacturers editor allows access to the information about each manufacturer stored in the database.

Only the Name is required. The Address, Phone, Fax and Web address will help with contacting the manufacturer if necessary. In addition there is space to 

enter any pertinent Notes.
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�   � TEST PROFILES
The Profiles editor provides access to all test profiles stored in the database.

The Profile Details box is also available for creating a new profile when a new model is created using the New Gauge Wizard.

XX Name
When creating a new profile, it will help to make the Name descriptive and specific, particularly if you will be using several similar profiles for different models. 

XX Units of Measure
Use the pull-down list to specify the correct Units of measure. 

XX Number of Excercise Cycles
Enter a non-zero Number of exercise cycles to remind the operator to exercise the gauges before beginning any calibration that uses this profile.

XX To Create a Uniform Series of Pressure Points

1	 Click on Ascending/descending points.

2	 Specify the minimum and maximum range of the profile and the number of ascending and descending points.

The Pressure list will be filled automatically.
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XX To Create a Non-Uniform Series of Pressure Points

1	 Click to select Custom.

Any points that are already listed will remain.

2	 Select a point to delete or move or click New to add a point.

3	 In the Condition Point dialog box enter a new point, and click OK.

The entered pressure value will be added to the list.

4	 Click Move Down or Move Up to position the selected point in the profile. 

5	 Double-click on a point or click on the Delete button to remove the selected point.

When the desired profile is achieved, the profile can be saved for use with any model.
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�   � LOCATIONS

The Locations editor allows access to the information about each location stored in the database.

Only the Name is required to store and use a location in the database. The Address, Contact name, Phone, Fax and Email address will help with contacting the 

location if necessary. There is also a field for any Notes.

�   � PRESSURE UNITS

Units are specified for each model and that model’s associated profiles. The FastCalXP software includes 13 different defined system units. The names of these 

units and their PSI conversion factors are listed in Appendix A. These system units cannot be modified.

The Units editor provides access to all custom units stored in the database.

If a model has units not included in the units list, add the unit first, then add the model.

XX To Add Custom Unit

�� Specify the Name of the unit and the PSI conversion factor.
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�   � REFERENCES

The References editor provides access to all references stored in the database.

 

References are Crystal digital pressure gauges or calibrators automatically detected by FastCalXP. Refer to the Autodetection on page 15.

Any instrument used to measure ambient conditions in the calibration laboratory, such as temperature, humidity and barometric pressure, can also be con-

sidered a reference. These references are used to verify that ambient conditions are within specified ranges. If these references are included in the database, it 

may be desirable to list them in each certificate that is generated.

XX To add a reference for ambient conditions

1	 Enter the Manufacturer, Model number and serial number (SN).

2	 Enter the most recent Cal Cert number and the date that the certificate Expires.

3	 Enter a representation of the Accuracy of the instrument.

4	 Click the Include in all certs checkbox to list the reference in every certificate that is generated.
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�   � USERS

The Users editor provides the administrator access to the login information for all users of the FastCalXP software.

The Login name and Password are used in the login dialog box. The Full name of the user is attached to the saved calibrations and certificates completed by the 

user. The Authorization of Technician or Administrator defines the privileges of the user. There is also a field for any Notes.

Refer to discussions of login options and security settings in the Settings and Options on page 26.

�   � MULTIPLE DATABASE SUPPORT

FastCalXP is designed to work with Access Databases for data storage. By enabling Multiple database support in the Options dialog, it is possible to create and 

manage multiple databases directly from FastCalXP. While only one database can be open at a time, this feature simplifies the process of switching between 

databases.

It is important to understand that you will not be able to share any data between databases, including records of references, gauges, models, etc. In addition, 

many settings, such as the default template, are stored within the database (see Where Settings Are Stored on page 31 , for more details). Be sure you 

understand the implications of using multiple databases before enabling this feature. For example, if you are using the same references in multiple databases, 

you will have duplicate entries in each database, and when the gauge is recalibrated, the new calibration date will need to be changed in every database that 

uses the reference.
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If multiple database support is enabled, when the Change button is clicked in the Manage Database dialog, the following dialog appears:

XX  To Add a Database to the List of Available Databases

1	 Click the Add Existing Database button.

2	 Browse to the database and click Open.

After selecting the database, you will be asked for a name, which will be displayed along with the database file name. This name is also displayed in the title 

bar of the application to indicate which database is in use.

XX To Create a New, Blank Database

1	 Click the Create New Database button.

2	 Browse to where you would like to store the database and provide a name. 

The Edit and Remove buttons allow you to change settings for or remove a database entry, respectively.

XX To select the database you want to use

�� Click on the database entry and then click the Use button.

If you are changing the database file after FastCalXP has started, you will need to exit and restart the program before the database change will go into effect.

XX To have this dialog appear every time FastCalXP starts

�� Click the Open this dialog every time FastCalXP starts checkbox. 

This will allow you to select the database during startup of FastCalXP without needing to change it from within the Manage Database dialog.
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Menus and Windows

�   � COMMAND SUMMARY

Following is a list of all commands available in the FastCalXP menu structure.

XX File
Create New Gauge	������������������������������������������������� Use the New Gauge Wizard to create a new gauge.

Lookup Existing Gauge 	��������������������������������������� Load a gauge.

Load Previous Data	����������������������������������������������� Load existing calibration data for the loaded gauge.

Load Certificate Data	������������������������������������������� Load data for an existing certificate associated with the loaded gauge.

Save 	��������������������������������������������������������������������������� Save pressure calibration data that has not yet been saved.

Generate Certificate	��������������������������������������������� Create an Excel format certificate from the currently loaded data.

Login 	������������������������������������������������������������������������� Enter a username and password. Change the user.

Exit 	����������������������������������������������������������������������������� Close FastCalXP.

XX View
Detailed Data	��������������������������������������������������������� Display a table of the currently loaded calibration data.

Certificate	����������������������������������������������������������������� View the currently loaded certificate.

Upcoming Calibrations Report	������������������������� Display a table showing calibrations that are due.

Toolbar	 	��������������������������������������������������������������������� View/hide the toolbar.

Status Bar	����������������������������������������������������������������� View/hide the status bar.

XX Tools
Look up Certificate 	����������������������������������������������� Pull up a certificate by number.

Manage Database	������������������������������������������������� Open the database manager.

Options		��������������������������������������������������������������������� View the settings and options dialog.

XX Help
Help Topics	��������������������������������������������������������������� Open the FastCalXP PDF manual.

About FastCalXP 	��������������������������������������������������� Display information about this version of FastCalXP.
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�   � MAIN WINDOW

The FastCalXP Main Window provides a graphical representation of the program flow and the current status of the program and the calibration process.
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�   � CALIBRATION WINDOW

The FastCalXP Calibration Window provides a straightforward user interface for proceeding with a single calibration.
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Frequently Asked Questions

�   � GAUGES

XX Why doesn’t the gauge that I am looking for show up on the list in the Load Gauge window?
It is marked as hidden. Click the box that says Show hidden gauges. To un-hide the gauge edit the gauge with the Database Manager.

XX Why doesn’t a model that I have already entered show up in the pull-down menu in the New Gauge Wizard?
If you know that you have the correct manufacturer for the model, you may have entered the model under the wrong manufacturer originally. Use the Data-

base Manager to see if the model is listed. If it is listed, verify and correct the manufacturer that is associated with the model.

XX Every time I launch FastCalXP I get an error message that says “FastCalXP requires a database for operation, and was unable to open one. If 
this error persists, consult user’s manual for more details on how to recover. FastCalXP will now exit:”

To recover, relaunch FastCalXP to display the following message: “FastCalXP is unable to make a current backup of your database to [FilePath]. Do you want 
to continue?” Make note of the [FilePath] and then click “No” to exit FastCalXP.

Using Windows, browse to the folder that contains [FilePath]. Two files will be present. One will be the “Active” (and likely corrupt) database: “MyDatabase.mdb”. 

The other will be the backup copy of your database: “MyDatabase.mdb.1.0.bak”. (Your database name may vary slightly.)

Move or rename the database and the backup files, then relaunch FastCalXP. When prompted to select a database, choose a database file that has not been 

corrupted
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�   � REFERENCES

XX Why doesn’t the Calibration Wizard detect my reference?
Be sure that the serial cable connectors are properly seated and that the reference has been turned on. If the software still does not detect the reference, check the number of the serial port on the computer. 

Choose Options from the Tools menu.

On the Config Settings tab, verify that the XP2/Model 30 serial port is the same as that to which the serial cable is connected.

XX I am using a Model 30 for a reference. Can I still use Peak Mode?
Yes. The peaks are detected within the FastCalXP software so you can use a gauge that does not have its own peak feature. 

�   � UNITS

XX Why don’t I see anything in the Units portion of the Database Manager?
Only units added by an operator can be edited with the Database Manager so only these units are listed. Refer to the list of FastCalXP Pressure Units in Appendix A to find conversions to PSI.

�   � PEAK MODE

XX I have selected Peak Mode. Why doesn’t my computer beep when I stop at a target?
Auto Peak detection is not turned on. Choose Options from the Tools menu, click on the Calibration Settings tab and click to check the Auto Peak Detection box.
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Pressure Calibration Terms
Actual Mode	���������������� The data acquisition mode that takes the current reading from the reference at the desired moment of measurement.

As Left	���������������������������� The state of the gauge after it has had calibration adjustments made.

As Received	������������������ The state of the gauge when it is initially measured.

Comparator 	���������������� A device used to apply equal pressure to the gauge and reference.

Gauge	���������������������������� The instrument that is being calibrated, or the device under test (DUT). This might be a gauge or a transmitter.

GaugeCalHP	���������������� Crystal Engineering’s pressure comparator.

Model 30 	���������������������� A Crystal Engineering 30 Series digital pressure calibrator.

nVision	�������������������������� A Crystal Engineering nVision Reference Pressure Recorder. Includes Lab Reference model. 

Peak Mode	�������������������� The data acquisition mode that takes the most recent peak (or valley) from the reference at the desired moment of measurement.

Reference	���������������������� The instrument to which the DUT is compared during a calibration. Also, any instrument used to measure ambient conditions during the 

calibration.

XP2i	�������������������������������� A Crystal Engineering digital pressure gauge. Includes XP2 model.
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Appendix

�   � APPENDIX A: FASTCALXP PRESSURE UNITS

FastCalXP uses the following standard units and associated conversion factors from PSI. All conversion factors use a gravity constant of 9.80665 m/sec2.

1 PSI =	 27.6806 inches of water column (water at 4° C [39.2° F])

	 27.7070 inches of water column (water at 15.6° C [60° F])

	 27.7292 inches of water column (water at 20° C [68° F])

	 2.03602 inches of mercury (mercury at 0° C [32° F])

	 51.7149 millimeters of mercury (mercury at 0° C [32° F])

	 703.087 millimeters of water column (water at 4° C [39.2° F])

	 0.070307 kilograms per square centimeter

	 68.948 millibar

	 6.8948 kilopascals

	 0.068948 bar

	 0.006895 megapascals

�   � APPENDIX B: EXCEL TEMPLATE TAGS

Following is a list of Excel template tags used by FastCalXP to create certificates using search-and-replace operations.

Tags are always included within chevrons (e.g., <tag>) and they can occur anywhere within a template worksheet. However, FastCalXP will only search and 

replace in a worksheet that includes the <CertNum> tag. Bold tags must be present for FastCalXP to fill fields defined by other tags in the same group. 

Tags marked “Saved in Cert” are values that will remain constant within a certificate once the certificate is created, even if the information in the database 

is changed at a later date. For example, the gauge number for a given certificate will not change even if it is changed in the database after the certificate is 

created. Since the system can recreate the certificate at a later date, saved fields provide an assurance that the major elements within a certificate will not be 

modified after the certificate is created.

Some of the tags have a number sign (#) as part of the tag. This is to support multiple values of the same type (i.e., multiple references or data points) to be 

included in the certificate. For example, to have a certificate that has ten indicated pressure points for run 1, you would need to include <ARRun1Point1Indi-

cated> through <ARRun1Point10Indicated> tags in the template. To have a certificate that has multiple runs i.e. 5 runs, you would need to include <ARRun-

1Point1Indicated> through <ARRun5Point1I0ndicated>. The registry entry value for the following must be at least the same number of runs in the template: 

HKEY_CURRENT_USER\Software\Crystal Engineering\FastCalXP\Settings\ExcelMaxRuns Value Data “5”.
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Tag Name Description Saved in Cert

As Left Profile
<ALProfileActive> 0 = active, 1 = inactive (hidden)
<ALProfileExerciseCount> Number of exercises
<ALProfilePressureHigh> Maximum pressure in profile Yes
<ALProfilePressureLow> Minimum pressure in profile Yes
<ALProfileID> Database ID number of profile
<ALProfileName> Name of profile

As Received Profile
<ARProfileActive> 0 = active, 1 = inactive (hidden)
<ARProfileExerciseCount> Number of exercises
<ARProfilePressureHigh> Maximum pressure in profile Yes
<ARProfilePressureLow> Minimum pressure in profile Yes
<ARProfileID> Database ID number of profile
<ARProfileName> Name of profile

Gauge
<GaugeActive> 0 = active, 1 = inactive (hidden)
<GaugeID> Database ID number of gauge
<GaugeNickname> Gauge nickname
<GaugeNumber> Gauge number Yes
<GaugeSerialNumber> Gauge serial number Yes

Calibration Rep
<CalRepFullname> Calibration rep full name Yes

Certificate
<CertActive> 0 = active, 1 = inactive (hidden) Yes
<CertALCondition> Pass/fail condition: 0 = no data taken, 1 = failed, 2 = passed Yes
<CertARCondition> Pass/fail condition: 0 = no data taken, 1 = failed, 2 = passed Yes
<CertGaugeModifications> Memo field of modifications to gauge Yes
<CertEffectiveOn> Effective date of cert (when cert was created) Yes
<CertExpiresOn> Cert expiraton date = CertEffectiveOn + ModelCertPeriod Yes
<CertNum> Certificate number Yes

Globals
<GlobalsCalMode> Calibration mode
<GlobalsDefaultCertTemplate> Default certificate
<GlobalsHeadCorrection> Head correction
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Tag Name Description Saved in Cert

Location
<LocationActive> 0 = active, 1 = inactive (hidden)
<LocationAddress> Location address
<LocationContact> Location contact
<LocationEMail> Location email
<LocationFAX> Location FAX
<LocationID> Location database ID
<LocationName> Location name
<LocationNotes> Location notes
<LocationPhone> Location phone

Manufacturer
<MfgActive> 0 = active, 1 = inactive (hidden)
<MfgAddress> Manufacturer address
<MfgFAX> Manufacturer FAX
<MfgID> Manufacturer database ID
<MfgName> Manufacturer name Yes
<MfgNotes> Manufacturer notes
<MfgPhone> Manufacturer phone
<MfgURL> Manufacturer URL

Model
<ModelActive> 0 = active, 1 = inactive (hidden)
<ModelAccuracystatement> Model accuracy statement
<ModelALProfileID> Model AL profile database ID
<ModelALQuantity> Model AL profile quantity
<ModelARProfileID> Model AR profile database ID
<ModelARQuantity> Model AR profile quantity
<ModelCertPeriod> Model cert period
<ModelCertTemplate> Model cert template
<ModelID> Model database ID
<ModelName> Model name Yes
<ModelRangeMax> Model maximum pressure
<ModelRangeMaxmA> Model maximum milliamps
<ModelRangeMin> Model minimum pressure
<ModelRangeMinmA> Model minimum milliamps
<ModelResolution> Model pressure resolution
<ModelType> Model type
<ModelUnitID> Model Unit database ID
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Operator The Operator User is the account that is logged in when the cert was created.
<OperatorActive> 0 = active, 1 = inactive (hidden)
<OperatorAuthLevel> Operator authorization level
<OperatorFullname> Operator full name
<OperatorNotes> Operator notes
<OperatorUserID> Operator database ID
<OperatorUsername> Operator login username

Quality Representative
<QualRepFullname> Quality rep full name Yes

Session The session is the top level object that contains everything else about the calibration.
<SessionDate> Session date (last time data saved)
<SessionID> Session database ID

Session User The Session User is the account that did the calibrations
<SessionUserActive> 0 = active, 1 = inactive (hidden)
<SessionUserAuthLevel> Session user authorization level
<SessionUserFullname> Session user full name
<SessionUserNotes> Session user notes
<SessionUserUserID> Session user database ID
<SessionUserUsername> Session user login username

Units For UnitID < 1000, all fields are saved in the certificate as they are built-in units
<UnitActive> 0 = active, 1 = inactive (hidden) *
<UnitID> Unit database ID *
<UnitName> Unit name *
<UnitPSIConversion> Unit PSI conversion factor *
Tag Name Description Saved in Cert

References
<Reference#SN> Reference serial number Yes
<Reference#ID> Reference database ID Yes
<Reference#Manufacturer> Reference manufacturer Yes
<Reference#Model> Reference model Yes
<Reference#CertNumber> Reference certificate number Yes
<Reference#CertExpires> Reference certificate expiration Yes
<Reference#AccuracyStatement> Reference accuracy statement Yes
<Reference#MessageStore> Reference message store Yes
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Conditions
<ALCond#Pressure> As Left pressure set point Yes
<ARCond#Pressure> As Received pressure set point Yes

Data
<ARRun#Point#Indicated> AR indicated Yes
<ARRun#Point#Setpoint> AR set point Yes
<ARRun#Point#Applied> AR applied Yes
<ARRun#Point#Error> AR error Yes
<ARRun#Point#Tolerance> AR tolerance Yes
<ARRun#Point#Temperature> AR temperature Yes
<ARRun#Point#Passed> AR point passed Yes
<ARRun#Point#HARTIndicated> AR HART indicated Yes
<ARRun#Point#HARTError> AR HART error Yes
<ARRun#Point#HARTPassed> AR HART passed Yes
<ARRun#Point#mASetpoint> AR set point converted to mA Yes
<ARRun#Point#mAApplied> AR applied converted to mA Yes
<ARRun#Point#mAIndicated> AR mA indicated Yes
<ARRun#Point#mAToPressure> AR mA indicated converted to pressure Yes
<ARRun#Point#mAError> AR mA error Yes
<ARRun#Point#mAPassed> AR mA passed Yes
<ARRun#Point#mATolerance> AR mA Tolerance Yes
<ALRun#Point#Indicated> AL indicated Yes
<ALRun#Point#Setpoint> AL set point Yes
<ALRun#Point#Applied> AL applied Yes
<ALRun#Point#Error> AL error Yes
<ALRun#Point#Tolerance> AL tolerance Yes
<ALRun#Point#Temperature> AL temperature Yes
<ALRun#Point#Passed> AL point passed Yes
<ALRun#Point#HARTIndicated> AL HART indicated Yes
<ALRun#Point#HARTError> AL HART error Yes
<ALRun#Point#HARTPassed> AL HART passed Yes
<ALRun#Point#mASetpoint> AL set point converted to mA Yes
<ALRun#Point#mAApplied> AL applied converted to mA Yes
<ALRun#Point#mAIndicated> AL mA indicated Yes
<ALRun#Point#mAToPressure> AL mA indicated converted to pressure Yes
<ALRun#Point#mAError> AL mA error Yes
<ALRun#Point#mAPassed> AL mA passed Yes
<ALRun#Point#mATolerance> AL mA Tolerance Yes
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Support

�   � CONTACT US

Phone 	��������������������������������������������������� (805) 595-5477

Toll-Free	����������������������������������������������� (800) 444‑1850

Fax	����������������������������������������������������������� (805) 595-5466

Email 	����������������������������������������������������� crystal@ametek.com

Web	��������������������������������������������������������� ametekcalibration.com

Send your comments to: crystal@ametek.com

�   � WARRANTY

FastCalXP (THE “PRODUCT”) IS PROVIDED “AS IS.” CRYSTAL ENGINEERING CORPORATION DOES NOT AND CANNOT WARRANT THE PERFORMANCE OR RESULTS 

PURCHASER MAY OBTAIN BY USING THE PRODUCT. CRYSTAL ENGINEERING CORPORATION MAKES NO PROMISES, REPRESENTATIONS, OR WARRANTIES, EXPRESS 

OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE PRODUCT’S CONDITION, ITS CONFORMITY TO ANY REPRESENTATION OR DESCRIPTION, THE EXISTENCE OF 

ANY LATENT OR PATENT DEFECTS, ANY NEGLIGENCE, AND ITS MERCHANTABILITY OR FITNESS FOR A PARTICULAR USE. 

Good data processing procedure dictates that any Product be thoroughly tested with non-critical data before relying on it. The purchaser must assume the en-

tire risk of using the Product. ANY LIABILITY OF CRYSTAL ENGINEERING CORPORATION FOR A DEFECTIVE PRODUCT WILL BE LIMITED EXCLUSIVELY TO REPLACE-

MENT OF PURCHASER’S COPY OF THE PRODUCT WITH ANOTHER COPY OR, IF SO ELECTED BY CRYSTAL ENGINEERING CORPORATION IN ITS SOLE DISCRETION, 

REFUND OF THE INITIAL AMOUNT PAID BY PURCHASER TO CRYSTAL ENGINEERING CORPORATION FOR THE PRODUCT. IN NO EVENT WILL CRYSTAL ENGINEERING 

CORPORATION OR ITS SUPPLIERS BE LIABLE TO PURCHASER FOR ANY CONSEQUENTIAL, INCIDENTAL OR SPECIAL DAMAGES, INCLUDING ANY LOST PROFITS OR 

LOST SAVINGS, EVEN IF CRYSTAL ENGINEERING CORPORATION WAS ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY THIRD PARTY.

crystal@ametek.com
https://www.ametekcalibration.com/
crystal@ametek.com
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